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Навчально-методичний посібник присвячений вивченню середовища 

Mathcad та практичному застосуванню цього програмного забезпечення для 

інженерних розрахунків. Наведено велику кількість прикладів вирішення 

розрахункових завдань різної складності. До прикладів надаються пояснення. Усі 

приклади забезпечені результатами виконання. По кожній темі представлені 

практичні завдання для виконання лабораторних робіт.  

Призначено для студентів хімічних спеціальностей, які бажають 

застосовувати середовище Mathcad для інженерних розрахунків.  
 

 

The teaching and practical guide is devoted to study how to make the 

engineering calculations using the Mathcad software. The different examples of 

engineering tasks with the varied complexity are provided with step-by-step explanation 

with corresponding illustrations. The obtained results are provided. Each subject 

includes the explained case studies and the tasks for work in class and individually.  

The teaching and practical guide is aimed for the students studying in chemical 

engineering, which want to use Mathcad for engineering calculations. 
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Introduction 

 

Mathcad is used to perform, document, and share the calculations 

and design work. Mathcad's interface is seen in standard mathematical 

notation, text, and graphs collected in a single worksheet, what makes 

Mathcad perfect for engineering calculations and further collaboration.  

In the most general sense, Mathcad combines 

– engineering-oriented mathematics notation and functionality,  

– a numeric and symbolic computational engine,  

– flexible, full-featured word processing and visualization tools. 

Mathcad is used for engineering problem-solving productivity and 

presentation of solutions. It allows engineers to work with powerful 

mathematics tools. Mathcad delivers all the solving capabilities, 

functionality, and robustness needed for calculation, data manipulation, and 

engineering design work. Its interface makes commonly used features 

accessible and natural. By allowing text, math, and graphics to be 

combined in a single worksheet environment, solutions are easy to 

visualize, illustrate, verify, and annotate. 

The present teaching and practical guide observes 12 subjects 

connected to engineering calculations in Mathcad in the field of chemical 

engineering. Subjects 1 – 6 give the basic approaches for calculation in 

Mathcad, such as defining the variables, performing basic arithmetic 

calculations, working with functions and matrixes. The solution of more 

complex mathematical problems, such as finding the local minimum and 

maximum of functions, solving the equations in Mathcad and the system of 

differential equations are presented in Subjects 7 – 10. Subject 11gives the 

examples of experimental data approximation using different approaches. 

The standard programming operators in Mathcad and their application for 

solving the engineering problems containing logical test and loops are 

given. Each section contains the example with the detailed step-by-step 

explanation of the required action to solve the problem and corresponding 

illustrations. The number of tasks for individual work is provided for each 

subject.  
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Subject 1. GETTING STARTED WITH MATHCAD 
 

Mathcad 15 is the standard for Engineering Calculation and 

Communication. Mathcad is designed for engineering problem-solving 

productivity and presentation of solutions. Mathcad allows engineers to 

work with the most natural, powerful mathematics tools available while 

enabling managers to easily access, track, and reuse work done in their 

departments. Mathcad delivers all the solving capabilities, functionality, 

and robustness needed for calculation, data manipulation, and engineering 

design work. Its interface makes commonly used features accessible and 

natural. By allowing text, math, and graphics to be combined in a single 

worksheet environment, solutions are easy to visualize, illustrate, verify, 

and annotate. 

Mathcad is the only enterprise-wide solution for managing 

engineering design and attributes. The produced files are publishable into a 

variety of formats: XML, HTML, PDF, and RTF, and with the use of the 

Mathcad Calculation Server they can published live math on the Web using 

existing Mathcad worksheets. Mathcad's open application architecture 

combined with its support of .NET and its native XML format make it easy 

to integrate Mathcad into other engineering applications. 

In the most general sense, Mathcad combines 

• engineering-oriented mathematics notation and functionality,  

• a powerful numeric and symbolic computational engine,  

• flexible, full-featured word processing and visualization tools. 
 

1.1. Mathcad Toolbars 

The main Worksheet window view is presented in Fig. 1.1. You are 

currently in the Resources window, so make sure you are looking at the 

window with the toolbar pictured below. If you can't see it, try moving this 

window to the right, so both windows line up next to each other. 

The Worksheet window consists of the Resources or E-book window 

and the Worksheet window: 

– The Resources window has content that Mathsoft has written. You 

can add your own comments or annotations. You cannot delete or move 

any of the content that appears in the Resources window. You can, 

however, drag content or copy content into the Worksheet window and 

modify it there. 

– The Worksheet window in Mathcad is your own workspace. Each 

worksheet can be saved as a new file or you can open existing files in the 

Worksheet window. Some of the activities in these tutorials require you to 

work in the Worksheet window. 
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Figure 1.1 – The main view of Worksheet window 
 

Mathcad toolbars provide access to a number of following features, 

functions, and math operators: 

– The Menu bar. 

– The Math toolbar. 

– The Standard toolbar. 

– The Formatting toolbar. 
 

1.2. The Menu bar 

Mathcad Menu Commands consist of following items: File, Edit, 

View, Insert, Format, Tools, Symbolics, Window, Help. 

 

 
 

Figure 1.2 – The view of the File menu bar 
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The File menu contains the following items (Fig. 1.2): 

– New 

Opens a dialog displaying a list of templates to choose from. Choose 

"Normal" to create a new blank worksheet. 

– Open 

Lists worksheets in the current directory or allows user to browse by 

changing the selection in the Look in drop-down menu or by typing the full 

path to the file in the "File Name" box. 

– Close 

Closes the current worksheet. 

– Close & Return 

Closes the worksheet and returns to the OLE container application. 

This command is only available when you are editing an embedded 

worksheet in a separate window, as opposed to in-place. 

– Update 

Updates the worksheet in an OLE container application. This 

command is only available when you are editing an embedded worksheet in 

a separate window, rather than in-place. 

– Save 

Saves the worksheet in the current format. If the worksheet is new, 

Mathcad prompts you to specify the name and format. You can save a file 

as *.XMCD (Mathcad's native XML format), or *.XMCDZ (compressed 

XML format, which is a GZIP (RFC1952) format). 

– Save As 

Saves the worksheet as a new file, allowing you to save the 

worksheet with a new name or in a different format. 

– Save as Web Page 

Saves the worksheet as an HTML file for posting on a Web site. 

– Save Copy As 

Saves a copy of the embedded worksheet as a stand-alone file. This 

option is available only when Mathcad is used as an OLE server and is not 

in-place activated. 

– Page Setup 

Controls the page layout options for the active worksheet, including 

margins, paper size, source, and orientation, and printing text beyond the 

right margin.  

– Print Preview 

Displays the worksheet as it will be sent to the printer, according to 

the current page setup instructions. 
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– Print 

Prints the active worksheet. Using the Print dialog, you can specify 

options such as specific pages and number of copies to print. 

– Send 

Attaches your worksheet to a new email message, if you have a 

MAPI-compliant email application. 

– Properties 

Opens the File Properties dialog, allowing you to create and modify 

metadata for your worksheet. 

– Recent Files 

Lists recently opened files; click on a name to open the worksheet. 

The number of files listed is controlled from the Tools > Preferences 

dialog. 

– Exit 

Closes Mathcad. If you edited an open worksheet since it was last 

saved, you are prompted to save it before quitting. 
 

The view of other menu bars is presented in Fig. 1.3. The Window 

Menu provides the possibility to arrange the open windows and Help Menu 

contains the references to the Help topics and tutorials. 
 

1.3. The Math toolbar 

The view of the Math toolbar is presented in Fig. 1.4. 

Each button in the Math toolbar opens another toolbar of operators 

or symbols. To see which toolbar each button brings up, move the cursor 

over the button until a tooltip (small popup window) will show the button 

title, and a description of the button appears on the message line of the 

Status Bar. 

The Math toolbar contains following buttons: Calculator; Graphing; 

Matrix; Evaluation; Calculus; Boolean; Programming; Greek; Symbolic. 

The content of each toolbar is presented in Fig. 1.5. 
 

1.4. The Standard toolbar 

The Standard toolbar buttons are shortcuts to many of the commands 

in the File and Insert menus (Fig. 1.6). To learn what a button does, hover 

the cursor over the button until a tooltip shows the title, and a description 

appears on the message line of the Status Bar. To customize the Standard 

toolbar, right-click on it and choose Customize. 
 

1.5. The Formatting toolbar 

The Formatting toolbar contains scrolling lists and buttons to 

specify font characteristics in equations and text (Fig. 1.7). To learn what a 
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button does, hover the cursor over the button until a tooltip shows the title 

and a description appears on the message line of the Status Bar. 

 

 

 

 
a b c 

 

 

 

d f g 

 
Figure 1.3 – The view of the following Menu bars: 

a – Edit; b –View; c – Insert; d – Format; f – Tools; g – Symbolics 
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Figure 1.4 – The view of Math toolbar 

 

 

  

a – Calculator Toolbar; b – Graph Toolbar; c – Matrix Toolbar; 

 

 

 

d – Evaluation Toolbar; f – Calculus Toolbar; g – Boolean Toolbar; 

 

 
 

j – Programming Toolbar; k – Greek Toolbar; l – Symbolic Toolbar 

Figure 1.5 – The view of the Math toolbars 
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Figure 1.6 – The view of Standard toolbar 

 

 
 

Figure 1.7 – The view of Formatting toolbar 

 

1.6. Creating regions 

All worksheets are comprised of regions - text regions, math regions, 

graphs, and images. Math regions often depend on other math regions to 

calculate correctly.  

A definition must appear above or to the left of where it is being 

used, a procedure referred to as top/down, left/right protocol. With the 

exception of global definitions, math expressions in a worksheet are 

evaluated from left to right and top to bottom. Before using a variable or 

function, you must define it above and to the left of the expression in which 

you wish to use it. As you evaluate new expressions, you will see results 

flow down the page. 

In Mathcad the following expressions exist: 

– Numeric expressions are the expressions involving numbers and 

operators; 

– Symbolic expressions are expressions involving numbers, 

unknowns (variables), and operators; 

– Result format is the type of result, including: decimal, fractional, 

scientific, etc. 

Besides math regions, you can also add text and images next to the 

math in your worksheets. To create a text region: 

– Click to start the region. 

– Choose Text Region from the Insert menu, or press the double-

quote ["] key. You can also just start typing text and once you type a space, 

Mathcad begins a text region. A text box with a red text cursor appears. 

– As you type, the text box grows. The text is formatted according to 

the "Normal" text style. 

– When you finish typing, click outside the text region. Do not press 

[Enter]. Doing so simply creates a new line inside the text region. 
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Subject 2.  CALCULATION OF MATHEMATICAL EXPRESSIONS 

IN MATHCAD.  THE BUILT-IN FUNCTIONS 
 

2.1. Mathcad built-in constants 

Mathcad sometimes returns special symbolic constants that cannot be 

evaluated directly using the numerical equal sign. The constants predefined 

in Mathcad are presented in Table. 2.1 and Table 2.2. Mathcad can evaluate 

these constants numerically using the symbolic equal sign with the 

keyword "float." Alternatively, it is possible to define new constants using 

the output of the symbolic equal sign and then evaluate these constants 

with the numerical equal sign. 
 

Table 2.1 – Math constants  

Name Keystroke Default Value 
∞ [Ctrl] [Shift] Z 10

307
 

e e Value of e to 17 digits (with "Show trailing 

zeros" enabled): 2.71828182845904500 

π [Ctrl] [Shift] p  

or  

p [Ctrl] g 

Value of π to 17 digits (with "Show trailing 

zeros" enabled): 3.14159265358979300 

γ g [Ctrl] g Value of γ (Euler's constant) to 17 digits (with 

"Show trailing zeros" enabled): 

 0.57721566490153290 

i or j 1i or 1j The imaginary unit. 

% % 0.01; multiplying by % gives you the appropriate 

conversion. You can type [expression] % for 

inferred multiplication or use it in the unit 

placeholder. 

NaN NaN Not a number. 
 

Table 2.2 – Some system constants 

Name Default Value Use 
TOL .001 Controls iterations on some numerical 

methods. 

CTOL .001 Controls convergence tolerance in 

Solve Blocks. 

ORIGIN 0 Controls array indexing. 

FRAME 0 Controls animations. 

ERR NA Size of the sum of squares error for 

the approximate solution to a Solve 

Block. 

1L, 1M, 1T, 

1Q, 1K, 1C, 1S 

assigned by the 

selected unit system 

Define custom unit definitions for the 

base dimensions. 
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2.2. Mathcad operators 

Operators are symbols like "+" and "−" that link variables and 

numbers together to form expressions. The variables and numbers linked 

together are called operands. 

For example, in “  a
x + y

  “  the operands for the "+" are x and y. The 

operands for the exponent operator are a and the expression x + y. 

Insert arithmetic operators in Mathcad using standard keystrokes, 

like [*] and [+]. Alternatively, all of Mathcad's operators can be inserted 

from the Math toolbars. Choose Toolbars from the View menu to see the 

Math toolbars with operators. The keystrokes for each operator (Table 2.3) 

depend on the localized keyboard and operating system. The tooltips are 

for the US keyboards only.  

 

Table 2.3 – Mathcad keystrokes for math operators 

Display Keystroke Operator 

1 2 3 

:= [:] definition – defines a value as a variable to use 

in subsequent calculations 

= [=] evaluation – returns the numerical evaluation 

for the left side as a result on the right-hand 

side 

≡ [~] (tilde) global definition – returns a globally defined 

variable 

+ [+] addition – returns the sum 

+ ... [Ctrl] [Enter] addition with linebreak – returns the sum with 

terms on different lines 

− [−] negation – returns the negative  or   

subtraction – subtracts one number from 

another 

· [*] multiplication – returns the product 

 [/] division – return the result of one number 

divided by another 

÷ [Ctrl] [/] in-line division 

.. [;] Precedes last number in range 

 

[\] square root 

 

[Ctrl] [\] n-th root 

∫ [&] integration 

 

 n
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The end of the table 2.3 

1 2 3 

 
[^] exponentiation or matrix inverse 

 

[?] derivative 

 

[Ctrl] [Shift] [/] n-th derivative 

vi [ 

v[i 
array subscript 

M
<n>

 [Ctrl] 6 column selection 

× [Ctrl] 8 cross product – returns the vector cross 

product of 

 

[Ctrl] [−] vectorize 

|x| [|] magnitude or determinant – returns the 

magnitude (norm) of a vector, the absolute 

value of a scalar, or the determinant of a 

matrix 

 

[Ctrl] 1 transpose the matrix M 

 

[Ctrl] [Shift] 4 summation – returns the sum of the 

expression X as i goes from m to n 

 

[$] range sum – returns the sum over i of the 

expression X 

Σv [Ctrl] 4 sum of elements in vector – returns the sum 

of all the elements in the vector v. 

 

[Ctrl] [Shift] 3 product – returns the product as i goes from 

m to n of the expression X 

 

[#] range product – returns the product over i of 

the expression X 

n! [!] factorial – returns  

= [Ctrl] [=] equal to – returns 1 if x = y, 0 otherwise 

≠ [Ctrl] 3 not equal – returns 1 if x ≠ y, 0 otherwise 

< [<] less than – returns 1 if x < y, 0 otherwise 

> [>] greater than – returns 1 if x > y, 0 otherwise 

≤ [Ctrl] 9 less than or equal – returns 1 if x ≤ y, 0 

otherwise 

≥ [Ctrl] 0 greater than or equal – returns 1 if x ≥ y, 0 

otherwise 

 
x

y

 

x

d

d
 

n
x

d

d

n

 
M

T

 

m

n

i

X

 

i

X

 

m

n

i

X

 

i

X
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2.3. Built-in Functions 

It can be inserted any built-in function by choosing Function from 

the Insert menu to open the Insert Function dialog box. It is possible also 

to type the names of the built-in functions directly into Mathcad. Spelling 

and capitalization are important. The list of built-in function is presented in 

Table 2.4. 

Many common operations are represented by the appropriate 

mathematical notation, and so are considered operators, described 

separately. If you to install optional Extension Packs, you will have 

additional built-in functions. These also are available from the             

Insert > Function menu under the name of the Extension Pack. 

 

Table 2.4 – Built-in functions 

Mathcad 

function 

Description 

Log and Exponential Functions 

exp(z) Returns the number e raised to the power z ( ) 

log(z, [b]) Returns the base b logarithm of z. If b is omitted, returns 

base 10 log of z 

ln(z) Returns the natural logarithm (base e) of z 

Trigonometric Functions 

sin(z)  Return the trigonometric functions sine, cosine, tangent, 

secant, cosecant, and cotangent of z, respectively cos(z)  

tan(z) 

sec(z)  

csc(z)  

cot(z) 

Inverse Trigonometric Functions 

asin(z)  Return the value in radians of the arcsine, arccosine, 

arctangent, arcsecant, arccosecant, and arccotangent, 

respectively, that is, the angle whose sin, cos, and so on, 

is z 

acos(z) 

atan(z) 

asec(z)  

acsc(z)  

acot(z) 
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Insert Function Dialog Box contains the following items: 

– Function Category 

Lists categories of built-in functions. Choose "All" to see all the 

functions. 

– Function Name 

Displays a list of built-in functions in the selected category. 

– Syntax 

Shows the quantity and type of arguments required for the function. 

– Description 

Displays a description of the function. 

– Insert and OK buttons 

Inserts the function (together with placeholders for its arguments) 

into your worksheet. 

To apply a function to an expression you have already entered, 

surround the expression with the editing lines and then click OK button. 

 

2.4. Mathematical expressions 

Math in a Mathcad worksheet appears in familiar math notation – 

division with a fraction bar, exponents in a raised position, and built-up 

fractions just as in a book. Entering math expressions is very 

straightforward. The standard elements of the mathematical expression are 

presented in Fig. 2.1. 

 

y:= 2·ln(x)+1

Variable

Constant
Built-in function 

with x argument

Operator

Constant

OperatorOperator

 
 

Figure 2.1 – Parts of the mathematical expression 

 

Task 2.1  

Calculate the value of the expression 
2( 5)x  at  x = 1. 
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Mathcad text: 
 

 
 

To calculate the value of the expression, which contains a variable, it 

is needed firstly to define the variable and its value, and then to apply all 

the operators, as presented in (3), Mathcad text of Task 2.1. 

 

Task 2.2  
Calculate the value of the expression 
 

2

2 2 3

cos( )

1

sin ( )

x xa b a b x
y

x

R x b b x a x  
 

where  

 

Mathcad text: 
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Task 2.3  

Using Table 2.5 calculate the value of the expression in column (2) 

with the given initial data of variables in column (3). 

 

Table 2.5 – Data for calculation 

Variant Expression The values of 

variables 

1 2 3 

1 

2

2

2

2cos( 6)

1 2 sin

1
3 5

x
a

y

z
b

z  

1.426;

1.22;

3.5

x

y

z

 

2 3

2

( )
( )

1 ( )

y xx y x

y z y x
y x

y x  

1.825;

18.225;

3.298

x

y

z

 

3 

2

sin( )

sin( cos2 ) 1

bty e at b bt a

s b at t  

0.5;

1.7;

0.44

a

b

t

 

4 2 2 3

2 3 2 2

sin ( )

cos

x b b x a x

y x x a b  

1.5;

15.5;

2.9

a

b

x

 

5 3 2

2

( )

1ax

s x tg x b a x b

bx a
Q

e  

16.5;

3.4;

0.61

a

b

x

 

6 2 2

2 3

( 1) sin ( )

cos ( )

R x x b x a

S xb a x b
 

0.7;

0.05;

0.5

a

b

x

 

7 3 2 2

2
3

sin ( )

cos( )

y x a x b

x
z x b

a  

1.1;

0.004;

0.2

a

b

x
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The end of the table 2.5 

1 2 3 

8 3 sin

cos( sin )

f mtgt c t

z m bt t c  

2; 1;

1.2; 0.7

m c

t b
 

9 
2

2sin ( )

cos( )a

a
y btg x

x a

d ae bx a

 

3.2;

17.5;

4.8

a

b

x

 

10 2 2ln( ) sin ( )

cx

f a x x b

x x a
z e

x x b

 

10.2; 9.2;

2.2; 0.5

a b

x c
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3 2 3 2 2 3 2

1.2

3 5

( ) ( )

a c

b c

k a b a ab

 

2cos( 1.43 )
2

x
F x  

2.15;

2.5

c

x
 

 

12 

2 2 2

( ) ( )

( 2 )

z a b c a b c

y a b c ab
 

32
sin cos 2

4.1

x
F x  

1 28.6; 3 ;

3.3; 3.65

a b

c x
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Subject 3. DEFINING RANGE VARIABLES AND FUNCTIONS  

IN MATHCAD. PLOT A GRAPH OF FUNCTION 

 

3.1. Defining functions in Mathcad 

A function is a mathematical relationship between a set of arguments 

and a numerical result. The arguments are the variables that appear between 

the parentheses you use to define or evaluate a function.  

To define a function: 

1. Type the function name followed by a left parenthesis. A 

placeholder appears.   

 
2. Type a list of arguments separated by commas followed by a 

right parenthesis. 

 
3. Type [:] to see the definition symbol, :=. Another placeholder 

appears. 

 
4. Type anexpression or a string in the placeholder. 

f(x,y) := x + sin(y) 

 

Make sure any variables used in the right-hand expression are either: 

– previously defined, or 

– part of the argument list. 

If a variable in the right-hand expression doesn't satisfy one of these 

conditions, it appears in red as undefined. 

 

Task 3.1 

Define the function  in points: x = 0 and  x = 10. 

Solution in Mathcad: 
 

 
 

Task 3.2 

Define the function 
3

2 2( 2 ) 4 1L S x x S x , where 

3( ) sin 0,5S f f f  in point: x = 2. 
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Solution in Mathcad: 

 

 
 

3.2. Defining a range variables 

The range variable is the variable, for which some range of its 

variation is determined. 

To define a range variable: 

1. Type the name of the variable followed by a colon [:], to create a 

definition. 

2. In the placeholder, type the first number in the sequence of values.  

3. Type a comma, or, if you're defining a sequence in increments of 

one, go to step 5.  

4. Type the second number in the sequence.  

5. Type a semicolon [;]. Note that it appears as two dots ".."  

6. In the remaining placeholder, type the last number in the sequence.  

In Table 3.1. the examples of range variables are presented. And 

Table 3.2 contains the example how to define the range variables in 

Mathcad. 

 

Table 3.1 – Range variables examples 

Displayed in Mathcad Explanation 

1..20 Defines the range of numbers 1, 2, 3 ... 20. 

The increment is equal to 1. 

20..1 Defines the range of numbers 20, 19, 18 ... 1. 

The increment is equal to –1. 

1,1.1..5 Defines the range of numbers 1, 1.1, 1.2 ...5. 

The increment is equal to 0.1. 

5,3..-7 Defines the range of numbers 5, 3, 1, –1 ...–7. 

The increment is equal to –2. 
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Table 3.2 – Range variables definition in Mathcad 

No Type: See: 

1. b: 1 [Tab] 10 
 

 You get a range of numbers between 1 and 10 at whole number 

increments. 

2. k:3.5;12.5 
 

 You get a range of numbers between 3.5 and 12.5 at whole number 

increments. 

3. d:3.5,4.0;12.5 
 

 You get a range of numbers between 3.5 and 12.5 in increments of 

0.5. 

4. q:1/4 [Spacebar] ,1/2 [Spacebar] ;7/4 

 
 

You get a range of numbers between  and  in increments of . 

5. n:-6,-5.9;6 
 

 You get a range of numbers between –6 and 6 in increments of 0.1. 
 

3.3. Graphing Functions 

Graphs are easy to create and modify in Mathcad. You can create 2D 

and 3D plots in Mathcad or graphs from functions or data sets. A 2D graph 

can contain up to sixteen plots, all formatted differently. Three-dimensional 

plots can be created from a matrix, a function, or a set of vectors. In the 

case of matrices, the row and column numbers correspond to the x and y 

axes, respectively. The values of the matrix elements represent the heights 

above the xy plane. Similarly, a function uses ranges of x and y to generate 

values for height z (or a range over a single parameter for all axes). For a 

set of vectors or matrices, specify the x, y, and z coordinates independently. 

Two-dimensional plots in Mathcad: 

– X–Y Plot 

Inserts the X-Y plot operator containing placeholders for x and y 

values as well as endpoints of the axes. The independent range variable or 

vector should be defined, or Mathcad will choose a range using a 

QuickPlot. 

– Polar Plot 

Inserts the polar plot operator containing placeholders for an angle 

variable and a radial expression. The independent range variable or vector 

should be defined, or Mathcad will choose a range using a QuickPlot. 

 

b 1 10

k 3.5 12.5

d 3.5 4 12.5

q
1

4

1

2

7

4

1

4

7

4

1

4

n 6 5.9 6
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Three-dimensional plots in Mathcad: 

– Surface Plot 

Creates a surface plot or type [Ctrl] 2 or choose the Surface Plot 

button on the Graph toolbar. 

– Contour Plot 

Creates a contour plot or type [Ctrl] 5 or choose the Contour Plot 

button on the Graph toolbar. 

– 3D Scatter Plot 

Creates a scatter plot for which you can specify color and symbol 

properties or choose the Scatter Plot button on the Graph toolbar. No 

surface is drawn to connect the points. 

– 3D Bar Chart 

Creates a 3D bar chart or choose the Bar Plot button on the Graph 

toolbar. 

– Vector Field Plot 

Creates a 2D vector field plot of a matrix or choose the Vector Field 

Plot button on the Graph toolbar. 

The terms definitions: 

– plot is a single line, or trace, in a graph region; 

– graph is a set of axes with a scale into which plots may be placed; 

– argument is a variable or expression used in a function or graph 

to define the region. 

 

3.3.1. Graphing two-dimensional plots 

To create an X–Y plot: 

1. Define a range variable for the range of values over which to plot 

the expression, for example 

t := −5, −4.8 .. 5 

2. Choose Graph > X–Y Plot from the Insert menu, or type @, to 

create an x–y plot operator. The Math toolbar (Fig. 1.4) and Graph toolbar 

(Fig. 1.5b) should be opened. 

3. In the middle placeholder underneath the x-axis (horizontal axis), 

enter the range variable. 

4. In the middle placeholder beside the y-axis (vertical axis), enter 

the expression you want to plot (Fig. 3.1a). 

5. Click away from the plot or press [Enter]. One point is plotted for 

each value of the range variable and, unless you specify otherwise, they are 

connected with straight lines (Fig. 3.1b). 
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a          b 
 

Figure 3.1 – Plotting x–y graph 

 

Task 3.3 

Define the function  , calculate its values in points: 

x = 0 and  x = 10. Plot the graph of function. 

Solution in Mathcad: 

 

 
 

Note: If the variable range is not defined, Mathcad will plot the 

graph within default values –10 to 10. 
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Task 3.4 

Plot the graphs of two functions:  and  in one 

graph. The variable  varies from 1 to 10, the increment is equal to 0.1. 

Solution in Mathcad: 
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Task 3.5 

Using Table 3.3 plot the graph of the function from column (2) with 

the range of variable given in column (3) and increment provided in 

column (4). 

 

Example of Task 3.5 solution 

Plot the graph of function  y = 2x + lg(x) + 0.5, in the range 2 ≤ x ≤5, 

taking increment h = 0.1. 

Solution in Mathcad: 
 

 
 

Table 3.3 – Data for calculation 

No Function The range of variables Increment 

1 2 3 4 

1 sin( ) cos( )y x x  x  h = 0.1 

2 2 4 sin( )y x x  x  h = 0.1 

3 cos( ) 1y x x  7 4,5x  h = 0.1 

4 2 cos( ) 7y x x  x  h = 0.1 
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The end of the table 3.3 

1 2 3 4 

5 lg( 1) 3y x x  0 15x  h = 0.1 

6 2 ln( ) 2 1y x x  1 50x  h = 0.1 

7 cos( ) 2y x x  1,7 4,5x  h = 0.1 

8 2 4 sin( )y x x  x  h = 0.1 

9 2( 4) 9y x x  
0,5 7x  h = 0.1 

10 4 3 22 3 52y x x x x  0 6x  h = 0.1 

11 3( )y arctg x x  5 10x  h = 0.1 

12 sin(3 ) 1y x x  0 6x  h = 0.1 

 

Task 3.6 

Do the Tasks listed in Table 3.4. 

 

Table 3.4 – Tasks for calculation 

No Task description 

1 2 

1 Plot the graph of the reaction velocity according to the relation: 
0.103778.56 ; 1 25; 1K e  

2 Plot the graph of the humidity x (in percent of dry substance) 

depending from time t, min according to the relation: 
1.4568 0.0093810 ; 0 100; 5tx t t  

3 Plot the graph of relation between the mixture amount y (in %), 

which is taken from the evaporation unit, and its output x (in kg/h) 

according to the equation: 
2.071 75.789 10 0.048; 250 2000; 100y x x x  

4 Plot the graph of relation between the atmospheric pressure p (in 

mm Hg) and barometric height h (in km), according to the equation: 
0.0531760 10 ; 0 6; 0.2hp h h  

5 Plot the graph of relation between the atmospheric pressure p (in 

mm Hg) and barometric height h (in km), according to the equation: 
0.0531760 10 ; 0 6; 0.2hp h h  
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The end of the table 3.4 

1 2 

6 Plot the graph of the humidity x (in percent of dry substance) 

depending from time t, min according to the relation: 
1.4568 0.0093810 ; 0 100; 5tx t t  

7 Plot the graph of relation between the air temperature inside the 

dryer T (in K) during the day, where τ are the hours, according to the 

equation 

80 14.99cos(15 37) 18cos(30 353)T ,   0 24 

8 Plot the graph of the relation between the solubility of the sodium 

salt of hypochlorous acid in water x (in g/100 g of water) from its 

temperature t (in °C) according to the equation: 
0.19397.894 4.82; 0 60; 2tx e t t  

9 Plot the graph of the relation between the friction factor in tubes τ 

depending from the Reynolds number Re: 

0.254

0.398

Re
,           3000 Re 16000; Re 1000  

10 Plot the graph of the relation between the air volume content in 

water ν (in ml, taken at given temperature t, °C and 760 mm Hg) and 

temperature t, °C: 

( 5) ( 1.386 0.0375 ) 25.68; 0 25; 1t t t t  

 

3.3.2. Graphing three-dimensional plots 

Three-dimensional scatter plots allow to visualize x, y, and z 

coordinates in space. They are useful for drawing parametric curves or for 

observing clusters of data in 3D space. To create a scatter plot, it is needed 

to define a function, a matrix of z-coordinates, or three vectors or matrices 

specifying the x, y, and z coordinates. Then, 

1. Choose Insert > Graph > Scatter Plot to create a scatter plot 

region. Functions for scatter plots can be parametric.  

2. Place the name of the matrix, function, or set of functions in the 

placeholder at the bottom left of the plot. If you enter a set of function 

names, defining a parametric surface, enclose them in parentheses 

(Fig. 3.2).  

3. Click outside the plot or press [Enter].  

The collection of points is rendered in three-dimensional space. 

Mathcad draws the points with black dots, unless you specify otherwise. 

Double-click on the plot to get formatting options. 
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A scatter plot of a function is created using default ranges and grids 

for the independent variables. To change them, double-click on the graph 

and use the options in the QuickPlot Data tab of the 3D Plot Format dialog 

box. 
 

 
 

Figure 3.2 – Plotting 3D scatter 

 

Task 3.7 

Plot the 3D graph of the function . 

Solution in Mathcad: 
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Task 3.8 

Plot the 3D graph of the matrix S, 
 

 

 

where , . 

 

Solution in Mathcad: 
 

 
 

Task 3.9 

Plot the 3D graph of the matrix , where function 

, x and y are matrixes with the values calculated 

according to the following relations:  

;    ,  

, . 

Solution in Mathcad: 
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Subject 4. CALCULATION OPERATORS.  

NUMERICAL ESTIMATION OF DERIVATIVES AND 

INTEGRALS. SYMBOLIC CALCULATIONS 
 

4.1. Evaluating expressions numerically or analytically 

You can use calculus operators to evaluate expressions numerically 

or analytically. Click on the Calculus icon button in the Math toolbar to 

bring up the Calculus toolbar (Fig. 4.1), or choose Toolbars > Calculus 

from the View menu. 
 

 
 

Figure 4.1 – Calculus toolbar 
 

The Calculus toolbar contains the following operators: derivative,   

n-th derivative, infinity, definite integral, indefinite integral, summation, 

summation with range variables, iterated product, iterated product with 

range variables, two-sided limit right-hand limit, left-hand limit, gradient. 

For example, to perform the summation using the summation 

operator, taken over all values of an index, it is needed either cast the 

elements to be summed or multiplied as vectors, or implicitly specify the 

elements in the range of the operator itself. 
 

Task 4.1  

Calculate the value of the expression  
 

 

Solution in Mathcad: 
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Task 4.2 

For the given function 
2( ) ( 1) sin( 0.5)y x x x  on the specified 

range [–1, 1]. Calculate: 

1. The value of differential in point, which divide this range with the 

step 0.5; 

2. The integral of this function on this range. 

Solution in Mathcad: 
 

 
 

Task 4.3 

Using Table 4.1 take the function from column (2) on the range 

specified in column (3) and calculate: 

1. The value of differential in point, which divide this range with the 

step 0.5; 

2. The integral of this function on this range. 

 

Table 4.1 – Data for calculation 

Variant Function The range of variables 

1 2 3 

1 sin( )0.37 xe  [0, 2] 
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The end of the table 4.1 

1 2 3 

2 0.5 lg( )x x x  [1, 3] 

3 
1

ln( 2)x x
 [1, 3] 

4 ( 1.9) sin( 3)x x  [0, 3] 

5 
3 cos( )

2

x

x
 [1, 3] 

6 
2

cos( 2)

x

x
 [–2, 0] 

7 
22.6 ln( )x x  [1, 3] 

8 
2 cos( 4)x x  [2, 4] 

9 3 ln( )x x  [1, 4] 

10 
2 ( 2)x tg x  [1, 3] 

11 
21.3 lg( )x x  [1, 3] 

12 ( 4) sin( 0.1)x x  [1, 3] 

 

4.2. Symbolic Calculations in Mathcad 

Besides doing numerical calculations, Mathcad can also perform 

operations on symbolic expressions – expressions that contain variables or 

mathematical symbols – and return the results in symbolic form. 

These expressions are evaluated using the symbolic equal sign →, 

rather than the numerical equal sign =. To insert the symbolic equal sign, 

press [Ctrl] [.]. It is possible to evaluate all of the standard Mathcad 

operators and many built-in functions symbolically. 

The features of evaluation of the expression symbolically: 

 Unlike the numerical equal sign, the symbolic equal sign doesn't 

require to assign values to the variables in an expression before evaluating 

it.  

 Symbolic results can reveal relationships among variables that 

might not be apparent from numerical results.  

 Symbolic calculations are immune to the round-off errors that are 

inherent in numerical calculations.  
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There are two ways to perform symbolic operations on an 

expression: 

1. Evaluate it using the symbolic equal sign. This is the 

recommended because the results are "live": if you later make a change to 

the worksheet anywhere above the expression or to the left of it in the same 

line, Mathcad updates the result automatically. To perform specific 

symbolic operations, such as factoring or expanding the expression, you 

can insert keywords before the symbolic equal sign.  

2. Use the Symbolics menu commands. The results are static, one-

time calculations that ignore all previously defined variables and functions. 

These results do not display the symbolic equals sign or keywords.  

 

Task 4.4 

Calculate the value of the integral of function 

. 

Solution in Mathcad: 
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Subject 5.  CREATING VECTORS AND MATRICES 

 

5.1. Defining array 

In two dimensions there are just two types of arrays: vectors and 

matrices.  

A vector is an array of just one row or column, while a matrix has 

multiple rows and columns. Mathcad functions that expect a vector 

argument generally require a column vector. 

There are several ways to define an array: 

 Create an array of empty placeholders with the Insert Matrix 

dialog box (Fig. 1.5c). Then click on each placeholder and enter a value or 

use [Tab] to move through the placeholders.  

 Use the subscript operator to define individual array elements, for 

example 

v[0 := 4i ;  v[1 := 1+3i 
 

 Create an array variable using the subscript operator and a formula 

relating the value of an array element to its indices with range variables, for 

example 

i := 0 ..9 

j := 0 ..9 

X[i,j := i
2
+j/2 

 

 Type numbers as a comma-separated list into a vector defined with 

a range variable, for example  
 

v[i := 1.345, 2.567, 3.678, 4.39, ... 
 

 Use one of the functions that generate special arrays or use a 

random number generator to create a vector of random numbers.  

 Import data from a file.  

Once an array is defined in terms of a variable name, you can use 

that variable in any calculation, where you would like to represent the 

array. 

Arrays can contain numbers, expressions, or strings. Arrays can also 

contain nested arrays. The simplest way to define an array element that is 

itself an array is to assign the element using the subscript operator. 

 

Task 5.1 

Create the vector  and matrix B, 
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Display all elements of vector A and the first and the last elements of 

matrix B.  

 

Solution in Mathcad: 
 

 
 

5.2. Indexing an array 

Arrays begin with index 0 by default. This can be changed by 

adjusting the built-in variable ORIGIN in the worksheet. Beware of not 

including all elements in an array in a calculation by creating a range 

variable which begins after the ORIGIN, or ends before the last element of 

the matrix or vector. For ORIGIN = 0, the last index of a vector from  

elements is  index. 

To change the ORIGIN for the whole worksheet, choose Worksheet 

Options from the Tools menu and go to the Built-in Variables tab, then 

enter a new value in the dialog box. 

It is possible also to reset the ORIGIN locally by redefining it in 

your worksheet, for example 

ORIGIN := 1 

sets the array index ORIGIN to 1 for all arrays below this definition.  

Changing the Task 5.1 indexing to starting with the first element 

index equal to 1 is listed below: 
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Task 5.2 

Plot a graph by the points x and y. Points x are vectors, calculated 

according to the following relations: . Point y are the function  

. Take 16 initial points. Display the transposed vector x. 

Solution in Mathcad: 
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Task 5.3 

Define t vector, which is the second row in matrix M. 
 

 

 

Solution in Mathcad: 
 

 



41 

Task 5.4 

1) Create the one-dimensional array . The array 

elements are calculated according to the relation: , where 

. Display the array elements. 

2) Calculate the value of the following expression: 
 

 

 

Solution in Mathcad: 
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Task 5.5 

Using Table 5.1 do the following: 

1) Create the one-dimensional array , where N is 

the number of elements in array listed in column (3). The array elements 

are calculated according to the relation presented in column (2), where 

. Display the array elements. 

2) Calculate the value of the following expression: 
 

 

 

where   are the numbers listed in column (4) 

 

Table 5.1 – Data for calculation Task 5.5 

No 
Relation for array  

elements 

N 

value 
Values   

1   1/ 2  1/ 3  i i

ia   
  3;    11;  2;    18n k m l

 

2   (2  1) 2i

ia i     2;    10; 1;    8n k m l  

3   1/ (3 2) (3   1)ia i i     5;    13; 3;   15n k m l  

4   10 /  i

ia i     4;    12; 3;   14n k m l  

5   10 /  i

ia i     9;    19; 3;   9n k m l  

6 
2  ln( ) /ia i i     5;    20; 4;    12n k m l  

7 
ln  i / (ln(5 ))i i

ia i     7;    25; 1;    9n k m l  

8   10 /ia i     4;    16; 5;   15n k m l  

9   ( ) /i

ia e i     2;    15; 4;   14n k m l  

10 
2  i

ia i e     1;    18; 2;   17n k m l  

11 
2 2 i

ia i e     3;   9; 2;  12n k m l  

12 
10

sin( )
i

i
a

i
    5;    10;  7;  18n k m l  
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Task 5.6 

Calculate the value of the following expression:   
 

8
1 3

1

i i

i

d a b , 

 

where  
ia  are the elements of one-dimension array 

1 2 8( , ,... )A a a a ;  

ib  are the elements of one-dimension array 
1 2 8( , ,... )B b b b . 

The components of arrays are optional numbers.  

Solution in Mathcad: 
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Task 5.7 

Do the Tasks listed in Table 5.2. 

 

Table 5.2 – Tasks for calculation 

No Task description 

1 2 

1 Calculate the value of the following expression: 
20

1

i i

i

y a b , 

where  ;  
ia  are the elements of one-dimension array 

1 2 20( , ,... )A a a a ;  

ib  are the elements of one-dimension array 
1 2 20( , ,... )B b b b . 

The components of arrays are optional numbers. 

2 Calculate the value of the following expression: 
10 10

1 1

i i

i i

F b k c , 

where  ; 

; 

ib  are the elements of one-dimension array
1 2 10( , ,... )B b b b ;  

ic  are the elements of one-dimension array
1 2 10( , ,... )C c c c . 

The components of arrays are optional numbers. 

3 Calculate the value of the following expression: 
1 2

20

1

( )j j

j

Z y x , 

where  ; 

jx  are the elements of one-dimension array 
1 2 20( , ,... )X x x x ;  

jy  are the elements of one-dimension array 
1 2 20( , ,... )Y y y y . 

The components of arrays are optional numbers. 
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Continuation of the table 5.2 

1 2 

4 Calculate the elements of array jz  according to the following 

expression: 

( ) /j j jz x y p , 

where  ; 

; 

jx  are the elements of one-dimension array 
1 2 10( , ,... )X x x x ;  

jy  are the elements of one-dimension array 
1 2 10( , ,... )Y y y y ; 

jz  are the elements of one-dimension array 
1 2 10( , ,... )Z z z z . 

The components of arrays 
1 2 10( , ,... )X x x x  and 

1 2 10( , ,... )Y y y y  

are optional numbers. 

5 Calculate the value of the following expression: 
20

1

5.6i i

i

P x y , 

where  ; 

ix  are the elements of one-dimension array 
1 2 20( , ,... )X x x x ;  

iy  are the elements of one-dimension array 
1 2 20( , ,... )Y y y y . 

The components of arrays are optional numbers. 

6 Calculate the value of the following expression: 
20

5

cos sini i

i

R x y , 

where  ; 

ix  are the elements of one-dimension array 
1 2 20( , ,... )X x x x ;  

iy  are the elements of one-dimension array 
1 2 20( , ,... )Y y y y . 

The components of arrays are optional numbers. 

7 Calculate the value of the following expression: 
20

2

3

1 ( 1)i

i

Z x m , 

where  ;           

; 

im  are the elements of one-dimension array 
1 2 20( , ,... )M m m m  

The components of array are optional numbers. 
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The end of the table 5.2  

1 2 

8 Calculate the value of the following expression: 
15

3

2

( )i

i

X z a , 

where  ;          ; 

iz  are the elements of one-dimension array 
1 2 15( , ,... )Z z z z . 

The components of array are optional numbers. 

9 Calculate the value of the following expression: 
20

3

1

( 1) ( 1)i

i

T x a x  , 

where  ;          ; 

ia  are the elements of one-dimension array 
1 2 20( , ,... )A a a a . 

The components of array are optional numbers. 

10 Calculate the value of the following expression: 
15

3

1

(2 )i

i

X z a , 

where  ;          ; 

iz  are the elements of one-dimension array 
1 2 15( , ,... )Z z z z . 

The components of array are optional numbers. 

11 Calculate the value of the following expression: 
8

2 2

2

1 ( )i

i

F c y x , 

where  ;      ;      ; 

iy  are the elements of one-dimension array 
1 2 8( , ,... )Y y y y . 

The components of arrays are optional numbers. 

12 Calculate the elements of array jz  according to the following 

expression: 
1/3  ( ( 1) )  ,x

i i iq e a k b  

where ; ; ;  

, ,i i ia b q , are the elements of one-dimension arrays 
1 2 10( , ,... )A a a a ;   

1 2 10( , ,... )B b b b  and 
1 2 10( , ,... )Q q q q  correspondingly. 

The components of arrays 
1 2 10( , ,... )A a a a  and 

1 2 10( , ,... )B b b b  are 

optional numbers. 
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Subject 6  

VECTOR AND MATRIX OPERATORS AND FUNCTIONS 

 

6.1. Vector and matrix operators 

The vector and matrix operators used in Mathcad are presented in 

Table 6.1. The examples of these operators are listed below. 
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Table 6.1 – Vector and matrix operators in Mathcad 

Operator Displayed Keystroke Description 

1 2 3 4 

Multiplication 

and  

Dot Product  

Operator 

x · y [*] If x and y are scalars, returns the 

product of x and y. 

If x and y are vectors, returns the 

dot product (inner product) of x and 

y, a scalar formed by multiplying 

element-wise the entries of the first 

vector with the complex conjugate 

of the entries of the second vector, 

and summing the results. 

If x and y are matrices, returns the 

matrix product of x and y. 

If one operand is a scalar and the 

other is a matrix, each element in 

the matrix is multiplied by the 

scalar. 

Division x

y
 

[/] 

[Ctrl] [/] 

Return x divided by y.  

If either x, y, or both, are vectors, 

division is performed element-wise.  

If y is a square matrix, then the 

result is x · y
-1

, that is, x times the 

inverse of y. 

Addition x+y [+] Returns the sum of x and y. 

If x and y are two matrices, they 

should have equal number of rows 

and columns. Then it summarizes 

the corresponding elements. 

If x is a matrix and y is scalar, it 

adds y to every element in x.  

Negation      –x [−] Negation for arrays negates each 

element in the array. 

Subtraction x–y [−] Subtracts y from x (x and y are 

scalars or arrays having the same 

dimensions).  

If both x and y are arrays, they must 

have the same number of rows and 

columns.  

If x is an array and y is a scalar, 

then x − y is an array formed by 

subtracting y from every element in 

x. 
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The end of the table 6.1  
1 2 3 4 

Powers of 

matrix 

xy  [^] Returns y raised to the x power. 

If y is a scalar and x is a vector, the 

result is a vector of the same size as 

x, whose i-th entry is y raised to the 

power xi. 

If y is a square matrix, the result 

depends on x. 

– x = 0 returns the identity matrix 

whose dimensions match those of 

y.  

– x = −1 returns inverse of y, if it 

exists.  

– When x is a positive integer, y 

is multiplied by itself x times.  

– When x is a negative integer, 

the inverse of y is multiplied by 

itself x times. 

Determinant 

or Magnitude  
| v | or M  [|] Returns the magnitude (norm) of a 

vector, the absolute value of a 

scalar, or the determinant of a 

matrix. 

Transpose TM  [Ctrl] 1 It returns the n × m array formed by 

interchanging the rows and columns 

of an m × n array. 

Vector Cross 

Product 

u × v [Ctrl] 8 Returns the vector cross product of 

u and v. 

Vectorize 
v  

[Ctrl] [−] Applies operators and functions 

element-wise to an array, allowing 

you to perform iterative calculations 

without using a range variable. 

Column <n>M  [Ctrl] 6 Returns the nth column of the array 

M. 

Array 

Subscript 
vn  or 

,Mm n  

v[n 

M[m,n 

Returns the nth element of v. 

Returns the element in row m and 

column n of matrix M. 
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6.2. Vector and matrix functions 

The vector and matrix functions used in Mathcad are presented in 

Table 6.2. The examples of these functions are listed below. 
 

 
 

Table 6.2 – Vector and matrix operators in Mathcad 

Function Description 

rows(A) Returns the number of rows in A. 

cols(A) Returns the number of columns in A. 

max(A, B, C, ...) Returns the largest value from A, B, C, ... 

min(A, B, C, ...) Returns the smallest value from A, B, C, ... 

length(v) Returns the number of elements in the vector v. 

last(v) Returns the index of the last element in the vector v. 
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Subject 7. SOLVING THE SET OF EQUATIONS 

 

A system of linear equations is a collection of two or more linear 

equations involving the same set of variables. A general system of m linear 

equations with n unknowns can be written as 
 

11 1 12 2 1 1

21 1 22 2 2 2

1 1 2 2

n n

n n

m m mn n m

a x a x a x b

a x a x a x b

a x a x a x b

 

 

Or it can be represented as: 
 

1

n

ij j i

j

a x b  

 

where 1,2, ,i m  is the equation number, totally n; 

1,2, ,j n  is the number of variables in equations set, totally m; 

ija  is the matrix of coefficients in the left part of equations (the 

coefficients of the system); 

ib is the vector of right parts (the constant terms); 

jx  are unknowns. 

 

7.1. Matrix method 

Representing the system of linear equations in matrix form, we will 

get: 
AX B , 

where 

– matrix A containing ija  elements, which is the matrix of 

coefficients of the system; 

– matrix B containing 
ib elements, which is the vector of the constant 

terms; 

– matrix X containing jx  elements, which are unknowns. 

 

The system in matrix form is AX = B. Matrix solution stands, that if 

the equation system is expressed in the matrix form, the entire solution set 

can also be expressed in matrix form. If the matrix A is square (has m rows 
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and n=m columns) and has full rank (all m rows are independent), then the 

system has a unique solution given by  
 

1X A B . 
 

where 1A  is the inverse of A . 

 

Task 7.1 

Find values , which are the solution of the following system of 

linear equations:   

2 3 6

2 3 4 16

3 2 5 12

x y z

x y z

x y z

 

 

Solution in Mathcad: 
 

 
 

7.2. Using Mathcad function lsolve( ) or solve block 

Mathcad contains the special function for solving linear systems – 

lsolve(A, b).  

It returns the solution x for the linear system of equations A·x = b, 

using LU decomposition. 

Arguments of  lsolve(A, b) function: 

– A is a real or complex matrix. If the matrix is square, it must be 

non-singular;  

– b is a real or complex vector or matrix having the same number of 

rows as A. 
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Task 7.2 

Solve the following linear system: 
 

1 2 3 4

1 2 3 4

1 2 3 4

1 2 3 4

0.87 0.27 0.22 0.18 1.21

0.21 0.45 0.18 0.33

0.12 0.13 1.33 0.18 0.48

0.33 0.05 0.06 1.28 0.17

x x x x

x x x x

x x x x

x x x x

 

 

Solution in Mathcad: 
 

 
 

The other way to solve the system of linear equations in Mathcad is 

to use solve block. 

A "Solve Block" refers to a group of Mathcad commands used to 

solve a system of linear, differential or partial differential equations, an 
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optimization problem, or a linear programming problem. The steps for 

these kinds of solving differ slightly, but each Solve Block involves the 

keyword Given, a set of constraints, a set of equations, and a solving 

function. 

Parts of a solve block: 

1. The keyword Given, typed as a math region.  

2. A set of equations and/or inequalities representing the constraints. 

The following operators (from Boolean toolbar, Fig. 1.5g) are used to 

create these constraints: 

– boolean equals, 

– greater than, 

– greater than or equal to, 

– less than, or 

– less than or equal to. 

3. An equation or system of equations to solve, along with initial 

conditions in the case of differential equations. Equality is indicated using 

the Boolean equals, [Ctrl] [=]. 

4. A solving function: 

 The functions Find or Minerr are used to solve a system of 

equations.  

Function Find(var1, var2, ...) returns the values of var1, var2...   

that satisfy the equations and inequalities in a Solve Block. If you are 

solving for n variables, the solve block must have n equations. Matrix 

notation is allowed, as is solving for matrix variables. The Find function 

chooses an appropriate method from a group of available methods, 

depending on whether the problem is linear or nonlinear, and other 

attributes. 

Output of the Find function may be assigned to a single variable, a 

vector of explicit variable names, or a function of other variable names 

within the solve block (including guess variables), parameterizing the solve 

block. 
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Task 7.3 

Solve the following linear system: 
 

1 2 3 4

1 2 3 4

1 2 3 4

1 2 3 4

0.87 0.27 0.22 0.18 1.21

0.21 0.45 0.18 0.33

0.12 0.13 1.33 0.18 0.48

0.33 0.05 0.06 1.28 0.17

x x x x

x x x x

x x x x

x x x x

 

 

Solution in Mathcad: 
 

 
 

A "Solve Block" with function Find(var1, var2, ...) is suitable to 

solve the systems of nonlinear equations. 
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Task 7.4 

Solve the following system of nonlinear equations: 
 

2

7 5 sin( ) 9

sin ( ) 3 2 2

2 5cos( ) 4 3

x y z

x y z

x y z

 

 

Solution in Mathcad: 
 

 
 

 

Task 7.5 

Do the Tasks listed in Table 7.1. 
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Table 7.1 – Tasks for calculation 

№ Set of Equations 

1 

0.85 0.05 0.08 0.14 0.48

0.32 1.43 0.12 0.11 1.24

0.17 0.06 1.08 0.12 1.15

0.21 0.16 0.36 0.88

x y z t

x y z t

x y z t

x y z t

 

2 

0.28 0.17 0.06 0.21

0.52 0.12 0.17 1.17

0.17 0.18 0.79 0.81

0.11 0.22 0.03 0.95 0.72

x y z t

x y z t

x y z

x y z t

 

3 

2.5 4 7 12.115

3 0.87

7 2 1.5 35.93

x y z

x y z

x y z

 

4 

7 20 91.65

4 5 2 14.85

10 2 15 87.2

x y z

x y z

x y z

 

5 

2 15 8 206.45

12 7 3 39.06

7 2 12 148.14

x y z

x y z

x y z

 

6 

6.05 0.13 8.57 19.6

15.46 8 13.94 23.8

7.18 12.6 0.07 0.04

x y z

x y z

x y z

 

7 

2 3 5 1

3 13 22 1

3 5 2 5

2 3 4 7 4

x y z t

x y z t

x y z t

x y z t

 

8 

1 2 3 4

1 2 3 4

1 2 3 4

1 2 3 4

0.87 0.27 0.22 1.28 1.21

0.21 0.3 0.45 0.18 0.33

0.12 0.13 1.33 0.18 0.48

0.33 0.05 0.06 1.28 0.17

x x x x

x x x x

x x x x

x x x x

 

9 

103

295

3142

321

321

321

xxx

xxx

xxx
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Subject 8. FINDING THE ROOTS OF EQUATIONS  

 

In mathematics, an equation is an equality containing one or more 

variables. Solving the equation consists of determining which values of the 

variables make the equality true. In this situation, variables are also known 

as unknowns and the values which satisfy the equality are known as 

solutions. 

Algebra studies two main families of equations: polynomial 

equations and, among them, linear equations. Polynomial equations have 

the form , where  is a polynomial. Linear equations have the 

form , where  is a linear function and  is a vector. 

 

8.1. Finding the roots of equations in Mathcad 

Mathcad provides the possibility to solve the equation with one 

unknown by the graphing method. It requires the presentation of the 

equation in the following form , when all its members are moved 

to the left part. The next step is to plot the graph of function . The 

points where the graph crosses the x-axis, are the solutions of the equation. 

If the graph doesn’t cross the x-axis, the equation doesn’t have the solution. 

The Mathcad function, which finds the roots of the equation is  
 

  root(f(var1, var2, ...), var1, [a, b]). 
 

It returns the value of var1 to make the function f equal to zero.  

If a and b are specified, root finds var1 on the interval [a,b]. 

Otherwise, var1 must be defined with a guess value before root is called. 

When a guess value is used, root uses the Secant or Mueller method; in the 

case where root bracketing is used, root uses the Ridder or Brent method. 

Arguments of root() function are as follows: 

 f  is a scalar-valued function of any number of variables.  

 var1 is a scalar variable found in f, the variable with respect to 

which the root is found.  

 a, b (optional) are real numbers, , such that  and  

have opposite signs. root searches for a root on the interval . 
 

Task 8.1 

Find the roots of the equation: 
 

sin( ) cos( ) 0x x
 

 

In the range x . 



59 

Solution in Mathcad: 
 

 
 

Answer:  

the equation sin( ) cos( ) 0x x  on the range x  has two roots: 

; . 

 

8.2. Finding the roots of polynomial equations 

In mathematics, a polynomial is an expression consisting of variables 

and coefficients which only employs the operations of addition, 

subtraction, multiplication, and non-negative integer exponents. 
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A polynomial in a single indeterminate  can always be written (or 

rewritten) in the form: 
2

2 1 0...n

nv x v x v x v
 

 

where  are the constants, and  is the indeterminate. 

A polynomial equation, also called algebraic equation, is an equation 

of the form: 
2

2 1 0... 0n

nv x v x v x v
 

 

In case of a univariate polynomial equation, the variable is 

considered an unknown, and one seeks to find the possible values for which 

both members of the equation evaluate to the same value (in general more 

than one solution may exist). 

The Mathcad function, which finds the roots of polynomial equation 

is polyroots(v). 

It returns a vector containing the roots of the polynomial whose 

coefficients are in v. By default, polyroots uses a LaGuerre method. 

LaGuerre's method is iterative and searches for solutions in the complex 

plane. 

Argument of polyroots() function: 

 v is a vector containing coefficients of a polynomial in which the 

first element is the constant term, and  . 
 

Task 8.2 

Find the roots of the equation: 
 

32 11 5 0x x . 
 

Solution in Mathcad: 
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Task 8.3 

Using Table 8.1 find the roots of the equation from column (2) on the 

range given in column (3). 

 

Table 8.1 – Data for calculation 

No Equation Range of x variable 

1 3 24 3 7 0x x x  5 5x  

2 3 22 6 3 0x x x  5 5x  

3 sin( ) 1 0x x  5 5x  

4 8cos( ) 6x x  5 5x  

5 2 ln( 7) 5 sin( ) 0x x  5 5x  

6 4 cos( ) 0.3 0x x  6 5x  

7 22 5 2xx  5 5x  

8 25 45 170 0x x  5 5x  

9 5 45 70 0x x  5 5x  

10 13 4 0x x  5 5x  

11 2 3 2 0x x  5 5x  

12 14 9 0x x  2 5x  

 

  



62 

Subject 9. FINDING MINIMUM  

AND MAXIMUM VALUES OF A FUNCTION 

 

9.1. Finding extrema according to Fermat's theorem 

In mathematical analysis, the maxima and minima of a function, 

known collectively as extrema, are the largest and smallest value of the 

function, either within a given range (the local or relative extrema) or on 

the entire domain of a function (the global or absolute extrema). Local 

extrema of differentiable functions can be found by Fermat's theorem, 

which states that they must occur at critical points. 

Fermat's theorem (also known as Interior extremum theorem) is a 

method to find local maxima and minima of differentiable functions on 

open sets by showing that every local extremum of the function is a 

stationary point (the function derivative is zero in that point). 

Fermat's theorem statement: 

– If a function has a local extremum at some point, then the 

function's derivative at that point must be zero. 

So, to find the extrema of the function, it is needed to find the points, 

where the derivative of the function is equal to zero. 
 

Task 9.1  

Find the extrema (local minima and maxima points) of the following 

function: 
3

3

3sin( ) 2.3
( )

2cos( )

x
T x

x x
, 

 

at the range 3 7x , taking the increment 0.1h . 
 

Solution in Mathcad: 
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Answer:  

the function 
3

3

3sin( ) 2.3
( )

2cos( )

x
T x

x x
has the following local extrema on the 

range 3 7x : 

1) minimum at point ;  ; 

2) minimum at point ;  ; 

3) maximum at point ;  . 
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9.2. Finding extrema using Mathcad functions 

The functions to find minimum and maximum values of the function 

in Mathcad are 

Minimize(f, var1, var2, ...) 

Maximize(f, var1, var2, ...) 
 

This function returns the values of var1, var2... that satisfy the 

constraints in a Solve Block, and make the function  

take on its smallest or largest value, respectively.  

Minimize and Maximize differ from Find and Minerr in that they 

can refer to functions defined outside of the Solve Block, rather than 

defined in the body of the Block. Functions are used as objective functions, 

rather than as constraints, as they are with Find and Minerr. If you are 

solving for n variables, the solve block must have n equations. The 

functions choose an appropriate method from a group of available methods, 

depending on whether the problem is linear or nonlinear, and other 

attributes. 

Arguments of Minimize / Maximize function: 

 var1, var2,... are the scalar or array variables that you want to 

optimize. Guess values for each variable must be defined above the Given 

keyword, or within the body of the Solve Block. If solutions are expected to 

be complex, complex guess values must be used.  

 f is a function defined above the Solve Block. The function is 

supplied without its arguments to Maximize and Minimize.  

 

Task 9.2 

Find the extrema (local minima and maxima points) of the following 

function: 
4 3 2( ) 3 2 0.5f x x x x x , 

 

on the range 0.7 1.8x . 
 

Solution in Mathcad: 
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Answer:  

the function 
4 3 2( ) 3 2 0.5f x x x x x has the following local extrema 

on the range 0.7 1.8x : 

1) minimum at point ;  ; 

2) maximum at point ;  ; 

3) minimum at point ;  . 
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Task 9.3 

Using Table 9.1 find the extrema of the function from column (2) on 

the range given in column (3) using the increment . 

 

Table 9.1 – Data for calculation 

No Equation Range of x variable 

1 3 2( ) lg( ) sin( ) lg( )Y x x x x  
1 10 0.2x h  

2 2cos( )( ) lg( ) sin( )xB x x x  
1 10 0.1x h  

3 5 2( ) ln( ) sin( ) 20Y x x x x  
1 10 0.2x h  

4 3 cos( )( ) sin( ) 0.3 5xZ x x x  1 8 0.1x h  

5 3 2( ) sin( ) 0.6T x x x  1 10 0.1x h  

6 cos( ) 2( ) 5 5sin( ) 3xF x x  
0 10 0.25x h  

7 3( ) (sin( ) 0.7)C x x x  1 10 0.1x h  

8 3( ) (cos( ) 0.2)S x x x  1 10 0.2x h  

9 3 sin( )( ) (cos( ) 0.5 ) ( 7)xZ x x x x  1 7 0.1x h  

10 3

3

3sin( ) 2.3
( )

2cos( )

x
T x

x x
 

3 9 0.1x h  

11 3 sin( )( ) (sin( ) 0.5) ( 7)xF x x x  1 10 0.2x h  

12 3( ) (cos( ) 0.5) ( cos( ))G x x x x  1 10 0.1x h  
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Subject 10.  DIFFERENTIAL EQUATION SOLVING.  

THE SYSTEMS OF DIFFERENTIAL EQUATIONS 

 

10.1. Ordinary differential equations 

Ordinary differential of a function f(x) of a variable x is a measure of 

the rate at which the value of the function changes with respect to the 

change of the variable. It is called the derivative of  f  with respect to x. If  x 

and y are real numbers, and if the graph of f is plotted against x, the 

derivative is the slope of this graph at each point. 

Ordinary differential equation (ODE) solvers in Mathcad solve an 

equation or system of equations for an unknown functions of one variable. 

To solve an ODE directly without creating a Solve Block, one of the ODE 

solvers can be used, which solve systems of ODEs of the form 
 

1

2

( , )

( , )

( , )n

f x y

f x yd
y

dx

f x y

, 

 

where y is vector of unknown functions of the independent variable x. 

To solve ODE in Mathcad use function 
 

rkfixed(init, x1, x2, intvls, D) 
 

It uses the fourth-order Runge-Kutta fixed-step method. 

The arguments used in rkfixed() function: 

 init is either a vector of n real initial values, where n is the number 

of  unknowns, or a single scalar initial value, in the case of a single ODE.  

 x1 and  x2 are real, scalar endpoints of the interval over which   

the solution to the ODE(s) is evaluated. Initial values in init are the    

values of the ODE function(s) evaluated at x1.  

 intvls is the integer number of discretization intervals used to 

interpolate the solution function. The number of solution points is the 

number of intervals + 1.  

 D is a vector function of  the form D(x,y) specifying the right-hand 

side of the system: 
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1

2

( , )

( , )
( , )

( , )n

f x y

f x yd
y D x y

dx

f x y
 

 

Task 10.1 

Solve the following ordinary differential equation: 
 

siny xy , 

 

at the range , with initial condition (0) 1y .  

Plot the graph of the solution. 

 

Solution in Mathcad: 
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Task 10.2 

Solve the following ordinary differential equation: 
 

2 3 3sin ( )y x y x y , 

 

at the range , with initial condition (0) 1y , taking increment 

.  

Plot the graph of the solution. 

 

Solution in Mathcad: 
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10.2. System of ordinary differential equations 

Using the rkfixed(init, x1, x2, intvls, D) function, it is possible to 

solve the system of ordinary differential equations. The difference with 

ODE solution is in provided arguments for ODE system: 

 init is either a vector of n real initial values for each ODE 

function.  

 D is a vector function of the form D(x,y) specifying the right-hand 

side of the system and providing the corresponding functions. 
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Task 10.3 

Solve the following system of ordinary differential equations: 
 

1

1 2

2

x y

y y

y e

, 

 

at the range , with initial conditions 
1 2(0) 0; (0) 0y y , taking 

increment . Plot the graph of the solution. 

 

Solution in Mathcad: 
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Task 10.4 

Using Table 10.1 do the presented tasks. 

 

Table 10.1 – Data for Task 10.4 

No Task description 

1 2 

1 Solve the ordinary differential equation: 

3

3 2
'y y

x x
;  

on the range 1 4x  with initial condition  1 1y . 

Plot the graph of function . 

2 Solve the ordinary differential equation: 
2' cos  y y tgx x ;  

on the range 
2

x  with initial condition 
1

2 2
y . 

Plot the graph of function . 

3 Solve the ordinary differential equation: 

21
' 4 5

2
y y x x

x
;  

on the range 1 3x  with initial condition 
3

y 1
2

. 

Plot the graph of function . 
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The end of the table 10.1  

1 2 

4 Solve the ordinary differential equation: 
2 3 3 2( 5) ( 5) 0 x y dx x y dy ;  

on the range 0 4x  with initial condition  y 0 2 . 

Plot the graph of function . 

5 Solve the ordinary differential equation: 

3 0
dy

y
dx

;  

on the range 0 4x  with initial condition  0 4y . 

Plot the graph of function . 

6 Solve the ordinary differential equation: 

ln 0tgydx x xdy ;  

on the range 
8 2

x  with initial condition  
8

y e . 

Plot the graph of function . 

7 Solve the ordinary differential equation: 
2

' 4
y y

y x
x x

;  

on the range 1 4x  with initial condition  1 2y . 

Plot the graph of function . 

8 Solve the ordinary differential equation: 
4 2 2 4 2 2 2( 6 ) 4 ( ) 0 x x y y dx x y x y dy ;  

on the range 1 4x  with initial condition  1 2y . 

Plot the graph of function . 

9 Solve the ordinary differential equation: 
2

2
' 5 1

3

x
y y

y
; on the range 1 3x  with initial condition  

1 2y . 

Plot the graph of function . 

10 Solve the ordinary differential equation: 

' 1 ln
y

xy y
x

; on the range 2 7x  with initial condition  

1
1y

e
. 

Plot the graph of function . 
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Subject 11. APPROXIMATION OF EXPERIMENTAL DATA 

 

In statistical modeling, regression analysis is a statistical process for 

estimating the relationships among variables. It includes many techniques 

for modeling and analyzing several variables, when the focus is on the 

relationship between a dependent variable and one or more independent 

variables (or 'predictors'). More specifically, regression analysis helps one 

understand how the typical value of the dependent variable (or 'criterion 

variable') changes when any one of the independent variables is varied, 

while the other independent variables are held fixed. Most commonly, 

regression analysis estimates the conditional expectation of the dependent 

variable given the independent variables – that is, the average value of the 

dependent variable when the independent variables are fixed. In regression 

analysis, it is also of interest to characterize the variation of the dependent 

variable around the regression function which can be described by a 

probability distribution.  

The selection of the proper approximation model depends on the 

behavior of the initial (experimental) data, as the approximation function 

 determines the mathematical object or phenomenon, what is under 

consideration. The standard approximation functions are listed in 

Table 11.1. 

 

Table 11.1 – Standard functions used for approximations 

No Name Graph Equation 

1 2 3 4 

1 Power function 

 

 

2 Exponential 

 

 

3 Linear 
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The end of the table 11.1  

1 2 3 4 

4 Logarithmic 

 

 

5 Polynomial 

 

 

 

The approximation of data points supposes the estimation of the 

proper function form and estimation of constants from the equations:  and 

. 

To calculate the deviation between the initial data and obtained 

approximating function, the following Mathcad function is used: corr(x, y) 

It returns the Pearson's r correlation coefficient of the elements in  

and : 

1

2 2

1 1

( )( )

( ) ( )

n

i i

i

n n

i i

i i

x x y y

r

x x y y

 
 

where 
1

1 n

i

i

x x
n

 is the sample mean, and analogously for y . 

Arguments: 

  and  are real or complex arrays of the same size.  

 

11.1. Linear regression of linear function 

The linear functions in math are expressed by the relation: 
 

( )y x a b x  
 

where  is the function argument, and  are the constants, which should 

be specified for the approximation. 

The build-in functions in Mathcad used for the linear approximation 

are: 
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– line(vx, vy)  
Returns a vector containing the coefficients a and b for a line of the 

form  that best approximates the data in vectors vx and vy in the 

least-squares sense. If you want the coefficients independently, use: 

– slope(vx, vy)  
Returns the slope of line that best fits data in vx and vy. 

– intercept(vx, vy)  
Returns the intercept of line that best fits data in vx and vy. 

– medfit(vx, vy)  
Returns a vector containing the coefficients a and b for a line of the 

form  that best approximates the data in vectors vx and vy using 

median-median regression. 

Arguments: 

– vx is a vector of real numbers representing the x values.  

– vy is a vector of real numbers representing the y values. vy must be 

the same length as vx.  
 

Task 11.1 

Find the functional dependence of wet content W, [%] in paint from 

the time t, [h] in the drying machine during the 16 hours drying process: 

 

Solution in Mathcad: 

 

t, (°C)   0 2 4 6 8 10 12 14 16 

, (%) 51 46 39 30 24 18 12 7.5 4.5 



77 

 
 

Answer: The function for data approximation is 

( ) 50.278 3.063W t t . 

The correlation between initial data and the obtained function is 

equal to 0.994. 
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11.2. Linear regression of non-linear function 

In case, when data behavior differs from linear, it is also possible to 

apply the linear approximation. But the  and  values from the linear 

function  will be functions. For example, if experimental 

data are likely to be the exponential function: ( ) b xy x a e , it is possible to 

use slope(vx, vy) and intercept(vx, vy) Mathcad functions, where vx is the 

vector od initial x points; as ( ) b xy x a e b  function takes the form 

inverse to exponential and is ln( ( ))y x . Here Mathcad functions will be 

slope(vx, ln(vy)) and intercept(vx, ln(vy)). 

 

Task 11.2 

Find the functional dependence of wet content W, [%] in paint from 

the time t, [h] in the drying machine during the 16 hours drying process: 

 

Solution in Mathcad: 

 

 

t, (°C)   0 2 4 6 8 10 12 14 16 

, (%) 51 46 39 30 24 18 12 7.5 4.5 
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Answer:  

The function for data approximation is 
0.15( ) 66.021 tW t e . 

The correlation between initial data and the obtained function is 

equal to 0.968. 
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11.3. Linear regression by the least squares method 

The method of least squares is a standard approach in regression 

analysis to the approximate solution of overdetermined systems, i.e., sets of 

equations in which there are more equations than unknowns. "Least 

squares" means that the overall solution minimizes the sum of the squares 

of the errors made in the results of every single equation. Least squares 

problems fall into two categories: linear or ordinary least squares and non-

linear least squares, depending on whether or not the residuals are linear in 

all unknowns. 

The using of least square method defines the determination of  

coefficients from the equation  from the condition of 

minimization of summation of square distances from the initial values and 

mathematically can be presented as follows: 

 

2

1

2

0 1

1

ˆ min

min

N

i i

i

N

i i

i

F y y

or

F y b b x

, 

 

where  are the initial x points; 

 are the initial y points (depending points); 

ˆ
iy  are the values, calculated according to the approximation function 

0 1
ˆ

i i
y b b x ; 

 is the number of experimental points. 

According to the least square method for linear regression the  

coefficients are specified according to the following relations: 
 

1 1 1

2

2

1 1

( )
N N N

i i i i

i i i

N N

i i

i i

N y x x y

b

N x x

;                  1 1

N N

i i

i i

y x

a b
N N

; 
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Task 11.3 

Find the functional dependence of air viscosity , [kPa s] from 

temperature T, [°C]: 

 

Solution in Mathcad: 

 

T, (°C)   0 100 200 300 400 500 600 700 800 

, 

(kPa s) 

0.0171 0.0218 0.0259 0.0294 0.0320 0.0357 0.0384 0.0411 0.0437 
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Answer:  

The function for data approximation is 
5( ) 0.019 3.26 10T T . 

The correlation between initial data and the obtained function is 

equal to 0.995. 
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11.4. Polynomial regression 

The polynomial functions in math are expressed by the relation: 
 

2
0 1 2( ) ... k

kY x b b x b x b x  
 

where  is the function argument, and  are the constants, which 

should be specified for the approximation;  is the polynomial level. 

When   the polynomial becomes a line;  

  it is parabola. 

The build-in functions in Mathcad used for the polynomial 

approximation: 

– loess(vx, vy, span) or  loess(Mx, vy, span)  

Returns a vector which interp uses to find a set of second-order 

polynomials that best fit the neighborhood of x and y data values in vx and 

vy in the least-squares sense. The size of the neighborhood is controlled by 

span. Can also be used for multivariate regression, where a matrix Mxy of k 

independent variables and a vector of dependent values, vy, are used to fit 

second-order polynomial surfaces in k dimensions. 

– interp(vs, vx, vy, x) or interp(vs, Mx, vy, X)  

Returns the interpolated y-value corresponding to x using the output 

vector vs from loess. If loess has been used to fit a multidimensional 

surface, X is a vector of independent variables at which to calculate the 

interpolated y-value. 

Arguments: 

 vx and vy are vectors of real data values and are of the same 

length;  

 Mx is a matrix of real data values. There is one column for each 

independent variable (k ≤ 4 columns). In this case, vy has the same number 

of rows as Mx;  

 vs is a vector generated by loess; 

 span is a positive real number specifying the size of the data 

neighborhood. Use larger values of span when the data behaves very 

differently over different ranges of  x. A good default value is span = 0.75;  

 x is the value of the independent variable at which you want to 

evaluate the regression curve; 

 X is the vector of values of the independent variables at which you 

want to evaluate the regression surface.  



84 

Task 11.4 

Find the functional dependence (3
rd

 level polynomial) of wet content 

W, [%] in paint from the time t, [h] in the drying machine during the 16 

hours drying process: 

 

Solution in Mathcad: 
 

 

t, (h)   0 2 4 6 8 10 12 14 16 

, (%) 51 46 39 30 24 18 12 7.5 4.5 
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Answer:  

The function for data approximation is 
2 3( ) 51.763 3.249 0.065 5.174W t t t t . 

The correlation between initial data and the obtained function is 

equal to 0.999. 
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11.5. Linear combination of functions 

The linear combination of functions in math is expressed by the 

polynomial: 

0 0 1 1 2 2( )y x a f x a f x a f x
 

 

where fi(x) is the i-th function of argument x, and it should be specified for 

the approximation. 

The build-in functions in Mathcad used for the approximation by 

linear combination of functions: 

– linfit(vx,vy,F)  

Returns a vector containing the parameters used to create a linear 

combination of the functions in vector F which best approximates the data 

in vx and vy in the least-squares sense. 

Arguments of  linfit() function: 

 vx and vy are vectors of real data values of the same length, 

corresponding to the x and y-values in the data set. There must be at least as 

many data points as there are terms in F.  

 F(x) is a vector of functions; each element is one linear functional 

term in the fit function. In the case of a single linear function, F is a scalar, 

F ={f0(x), f1(x), f2(x),....}..  

 

Task 11.5 

Find the functional dependence of mixture boiling temperature        

T, [°C] from its concentration C, [% of weight] from the: 

 

T, (°C )   110 115 120 140 180 220 260 300 

C, (% of weight ) 25 32 36 48 60 69 76 82 

 

Solution in Mathcad: 
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Answer:  

The function for data approximation is 

2

2
( ) 0.039 2021 8.686

1

c
t c c

c
. 

The correlation between initial data and the obtained function is 

equal to 0.995. 

 

Task 11.6 

Using Table 11.2 find the functional dependence of specific heat 

capacity from the temperature. The temperature T, [°C] is given in the table 

heading. The specific heat capacity data are listed for the substances 

according to the variant. For example, variant 2 contains the data for 

acetone. 
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Subject 12. PROGRAMMING IN MATHCAD 

 

12.1. Programming operators in Mathcad 

In Mathcad, a program is entered in the programming operator, a 

multi-step container for Mathcad program-control operators. Specific 

programming operators can be used to specify local assignments to 

variables or functions, loop over calculations, conditionally evaluate 

branches, add breakpoints, trap errors, and return values.  

Mathcad evaluates the sequence of statements in a program in the 

order specified by the programming operators then returns the result of the 

last step. Here is a simple example of a program. 

The operators comprise the Mathcad programming "language" are 

listed in Table 12.1. 

 

Table 12.1 – Programming operators in Mathcad 

Operator Keystroke Description 

1 2 3 

Add line ] Creates a new, empty line within a program, 

or creates the first line in a program if used in 

a blank region of the worksheet. Also called 

the Add Line operator. 

if [}] x if y 

Evaluates x if y is nonzero (true). The 

enclosing program proceeds to the next line 

regardless of whether x is evaluated or not. 

Conditional statements allow Mathcad to 

execute or skip certain calculations. Use a 

conditional statement whenever you want to 

direct program execution along a particular 

branch. 

for [Ctrl] ["] 

 
Evaluates z for each value of x over the range 

y. Typically, at least one expression in the 

loop body, z, uses the value of x to change the 

calculation for each evaluation. Use a for 

loop when you know exactly how many times 

you want the body of the loop to execute. 

return [Ctrl] [Shift] [\] The return operator halts the program and 

returns x. 



91 

The end of the table 12.1  
1 2 3 

break [Ctrl] [Shift] [ The break operator halts execution of the 

current loop and returns the last value 

calculated. The break operator is used in 

conjunction with a conditional statement to halt 

execution of a loop and return control to the 

first statement after the loop. This operator 

takes no arguments. 

Local 

assignment 
[{] x ← y 

Evaluates y numerically and assigns its 

contents to x. Variables and functions defined 

with this operator are only defined locally 

within the current definition, for example, 

within a program. Returns the value of the left-

hand-side. 

otherwise [Ctrl] [Shift] ] x otherwise 

Evaluates x if the if statement immediately 

preceding x is 0 (false). The otherwise 

operator only works with the if operator.  

while [Ctrl] ] 

 
Evaluates y while x is nonzero (true). The 

condition expression is evaluated at the 

beginning of the while loop, so it is possible 

that the loop never executes. The loop stops 

iterating as soon as the condition is false and 

returns the last value calculated in its body on 

the previous iteration. 

continue [Ctrl] [ The continue operator skips the remainder of 

the current iteration and returns to the first loop 

statement. In a for loop, the iteration variable is 

incremented. The continue operator is used in 

conjunction with a conditional statement to 

skip the current iteration and proceed to the 

next one. It takes no arguments. 

on error [Ctrl] ['] x  on error y 

Evaluates y. If y produces an error, evaluates 

and returns x. Otherwise returns the results of 

y. The on error operator is a distinct type of 

conditional operator, guiding execution only in 

the event of an error during calculation. 
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Conditional (if and otherwise) Operators 
 

x if y 

Evaluates x if y is nonzero (true). The enclosing program proceeds to 

the next line regardless of whether x is evaluated or not. Conditional 

statements allow Mathcad to execute or skip certain calculations. Use a 

conditional statement whenever you want to direct program execution 

along a particular branch. 

 

x otherwise 

Evaluates x if the if statement immediately preceding x is 0 (false). 

The otherwise operator only works with the if operator. In the following 

example, 
 

 
 

the function returns 0 if x is greater than 2 or less than −2. When x is 

between −2 and 2, the function returns the square root of 4 − x
2
. 

 

Operands: 

 x is any valid Mathcad expression.  

 y is any valid Mathcad expression that can evaluate to 0 in some 

cases. Only the return value of y is considered; it can be a boolean 

expression or any other Mathcad expression. For example, a local 

assignment or a sequence of programming steps is allowed.  
 

Program Loops 

A loop is a block of code that causes one or more statements (the 

body of the loop) to iterate until a termination condition occurs. There are 

two kinds of loops: 

 For loops are used when you know exactly how many times the 

body of the loop should execute. 

 While loops are used when you want to stop execution upon the 

occurrence of a condition but you don't know exactly when that condition 

will occur. 
 

For Loops 
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Evaluates z for each value of x over the range y. Typically, at least 

one expression in the loop body, z, uses the value of x to change the 

calculation for each evaluation. Use a for loop when you know exactly 

how many times you want the body of the loop to execute. 

 

Operands: 

 x is any valid Mathcad variable name.  

 y is a value or sequence of values. Most frequently, this is a range 

value, but you can also use a vector, or a comma-separated list of scalars or 

vectors, each of which results in a series of scalar values to be assumed by 

the iteration variable x. y can also be a series of matrices, separated by 

commas; x assumes the value of each matrix in turn. This is a convenient 

way to apply the same calculation to a set of matrices.  

 z is any valid Mathcad expression or sequence of expressions. For 

example, a local assignment, or a sequence of programming steps is 

allowed here. Use the Add Line operator to insert placeholders for 

additional statements.  

 

Example of for operator: 

 
 

While Loops 

 
 

Evaluates y while x is nonzero (true). The condition expression is 

evaluated at the beginning of the while loop, so it is possible that the loop 

never executes. The loop stops iterating as soon as the condition is false 

and returns the last value calculated in its body on the previous iteration. 
 

Operands: 

 x is any valid Mathcad expression or sequence of expressions that 

can evaluate to 0, frequently a boolean expression.  

 y is any valid Mathcad expression or sequence of expressions. At 

least one expression in the loop body must change the condition 
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expression, x, so that it becomes false; otherwise, the loop executes 

indefinitely and you need to stop it by pressing [Esc]. Use the Add Line 

operator to insert placeholders for additional statements.  

Example of while operator: 

 

 
 

Task 12.1 

Calculate the value of the expression 

( ) 2        at  x>1

cos( )            at   x=1

                   at x<1

a x b c

y a x x

a x b

 

where  

 

Mathcad text: 
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Task 12.2 

Using Table 12.2 calculate the conditional expression from column 

(2) using the coefficients given in column (3). 

 

Table 12.2 – Data for calculation 

No Expressions for calculation Initial data 
1 2 3 

1 1, 1

, 1

1 / , 1

x x

m a x b x

b a x

 

 a 12.4;   56.1  b  

2 2

3 2

sin , 0

ln (1 ), 0

, 0

x x

y x x

x c x

 

1.57с  

3 (1 ) / 2, 3

sin( ) 2,           3

3(1 ) / ( ),  

x x

g x x

xx a b

 

5.5; 1.2a b  

4 1 cos( ), 1

, 1

1/ ,

a x x

m a x b x

xx b a

 

0.001; 5.1a b  

5 , 1

sin( ),  1

1( ) / 2,

b y x y

w b y y

yx y

 

  0.15;       2b x  

6 1 cos( ) , 0

( ) / 2,  0

01,

x y y

f a y b y

ya

 

0.2; 0.01a b  

7 3 , 0

sin ,  0

0cos ,ax

x x a x

x ax x

xe ax

 

2.5a  
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The end of the table 12.2 

1 2 3 

8 2 2

3

7 , 1.3

7 ,   1.3

1.3lg( ) 7 ,

x x x

y ax x x

xx x
 

1.5a  

9 lg( 1), 2

( ) / 2,  2

21,

a y y

w a y b y

ya

 

0.2; 0.01a b  

10 2 ln , 2

1,  2

2cos ,at

at t t

y t

te bt

 

0.5; 2a b  

11 1 cos( ) , 0

( ) / 2,  0

01,

x y y

f a y b y

ya

 

0.2; 0.01a b  

12 2

3 2

sin , 0

ln (1 ), 0

, 0

x x

y x x

x c x

 

1.57с  

 

Task 12.3 

Create the program, which will calculate the elements of matrix  

according to relationship  and receive the vector with the 

following elements: 

1) The mean value of the sum of the martix’ column elements – 

vector ;  

2) The mean value of the sum of the martix’ row elements –      

vector : 

3) The number of matrix rows ; columns . 

 

Solution in Mathcad: 
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Task 12.4 

Using data from Table 12.3 create the program, which will calculate 

the elements of matrix  according to relationship presented in column (2) 

and receive the vector with the following elements: 

1) The mean value of the sum of the martix’ column elements – 

vector ;  

2) The mean value of the sum of the martix’ row elements –    

vector : 

3) The number of matrix rows and columns are given in column (3). 
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Table 12.3 – Data for calculation 

No Relations for calculation the matrix elements Values of  and  

1 , 1 ( )s ka s k  s  3;   4k  

2 , 10 1s ka s k  s  4;   5k  

3 , 2 5 ( 1)s ka s k  s  4;   3k  

4 , 10 2s ka s k  s  3;   5k  

5 , ( 2) (0.5 )s ka s k  s  3;   5k  

6 , 2 10s ka s k  s  5;   4k  

7 , (1 ) 2s ka k s  s  3;   4k  

8 , 0.5 0.1s ka s k  s  4;   5k  

9 , ( ) 0.5s ka s k  s  3;   5k  

10 , 3 2s ka s k  s  4;   3k  

11 , (0.1 ) 1s ka s k  s  3;   4k  

12 , 2 5 (1 )s ka s k  s  4;   3k  
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